Revista do Programa de Pés-Graduagdao em Geografia da
Universidade Federal do Piaui

—e_
—

f
i

PAISAGEM URBANA: IMPACTOS NA CONFIGURACAO E
AMBIENTE URBANOS DECORRENTES DA FORMA DE
APROPRIACAO E OCUPACAO DO ESPACO NA PROVINCIA DE
LUANDA/ANGOLA

Khoky Sefo Maria BARROS

Aluno do Doutorado em Geografia (PPGEQ) da Universidade Federal do Ceard, campus do
Pici

E-mail: sefobarros@gmail.com

Orcid: https://orcid.org/0000-0002-7487-9631

Edson Vicente da SILVA

Docente do Departamento de Geografia da Universidade Federal do Ceara
E-mail: cacauceara@gmail.com

Orcid: http://orcid.org/0000-0001-5688-750X

José Tito MORAIS

Docente da Faculdade de Ciéncias Naturais da Universidade Agostinho Neto, Luanda-Angola
E-mail: josetitomorais@hotmail.com

Orcid: https://orcid.org/0009-0006-8049-9869

Orlando Inacio JALANE

Aluno do Doutorado em Geografia (PPGEO) da Universidade Federal do Ceard, campus do
Pici

E-mail: ojalane@gmail.com

Orcid: https://orcid.org/0000-0001-5638-0311

Recebido
Julho de 2024

Aceito
Novembro de 2024

Publicado
Dezembro de 2024

Revista Equador (UFPI), Vol. 13, N° 2, Ano 2024, Edicéo Especial, p. 161-183.
Home: http://www.ojs.ufpi.br/index.php/equador
ISSN 2317-3491



http://www.ojs.ufpi.br/index.php/equador
https://orcid.org/0000-0002-7487-9631
https://orcid.org/0000-0001-5688-750X

Revista Equador (UFPI), Vol. 13, N° 2, Ano 2024, Edicéo Especial, p. 161-183.
Home: http://www.ojs.ufpi.br/index.php/equador

Resumo: As inundagBes em areas urbanas geram impactos expressivos tanto na sociedade
quanto no meio ambiente, especialmente em regibes com urbanizacdo acelerada, como Luanda,
Angola. Nas Ultimas décadas, a provincia passou por um intenso crescimento demografico,
impulsionado por movimentos migratérios e ocupacdes irregulares, resultando em
vulnerabilidades crescentes. Este estudo analisou os efeitos do aumento populacional nas areas
suscetiveis a inundagdes ao longo de 40 anos, considerando os marcos de 1975, 2002 e 2022.
A abordagem metodolégica incluiu entrevistas, questionarios, visitas a campo, uso de drones e
analise de cartas cartograficas, complementada por ferramentas como QGIS 3.2 e software R
para geoprocessamento e estatisticas. Os resultados apontam que o planejamento insuficiente e
a ocupacdo de territérios ambientalmente frageis ampliaram os riscos de alagamentos,
ocasionando deslizamentos de terra, perdas materiais e até mesmo mortes. Esses fatores tém
gerado uma reducéo significativa na qualidade de vida da populacdo, refletida em indicadores
socioecondmicos desfavoraveis. Além disso, a pressdo urbana sobre areas de risco compromete
sistemas naturais de escoamento de aguas pluviais, agravando os problemas relacionados as
chuvas. A auséncia de politicas publicas eficazes intensifica essas vulnerabilidades, tornando
essencial a adocao de estratégias de planejamento urbano que incluam infraestrutura adequada,
gestdo territorial e educacdo ambiental. Este estudo reforca a necessidade de uma abordagem
integrada e coordenada para mitigar 0s impactos das inundacGes e promover um
desenvolvimento sustentavel, capaz de transformar os desafios urbanos de Luanda em
oportunidades para um futuro mais resiliente e equilibrado.

Palavras-chave: paisagem; vulnerabilidade; inundacao; zonas urbanas; sociambiental.

URBAN LANDSCAPE: IMPACTS ON URBAN CONFIGURATION AND
ENVIRONMENT ARISING FROM THE APPROPRIATION AND OCCUPATION OF
TERRAIN IN THE PROVINCE OF LUANDA, ANGOLA

Abstract: Urban floods have significant impacts on both society and the environment,
especially in regions experiencing rapid urbanization, such as Luanda, Angola. Over recent
decades, the province has faced intense population growth driven by migration and informal
settlements, leading to increasing vulnerabilities. This study analyzed the effects of population
expansion in flood-prone areas over 40 years, focusing on the milestones of 1975, 2002, and
2022. The methodological approach included interviews, surveys, field visits, the use of drones,
and cartographic analysis, supported by tools such as QGIS 3.2 and R software for
geoprocessing and statistical analyses. The results highlight that inadequate planning and the
occupation of environmentally fragile territories have heightened flood risks, causing
landslides, material losses, and even fatalities. These factors have significantly reduced the
population’s quality of life, reflected in unfavorable socioeconomic indicators. Furthermore,
urban pressure on high-risk areas has compromised natural drainage systems, exacerbating
problems related to rainfall. The absence of effective public policies intensifies these
vulnerabilities, making it essential to adopt urban planning strategies that incorporate proper
infrastructure, territorial management, and environmental education. This study underscores the
need for an integrated and coordinated approach to mitigate flood impacts and promote
sustainable development, capable of transforming Luanda's urban challenges into opportunities
for a more resilient and balanced future..

Keywords: landscape; vulnerability; flooding; urban areas; socio-environmental.
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PAISAJE URBANO: IMPACTOS SOBRE LA CONFIGURACION URBANA Y EL
MEDIO AMBIENTE DERIVADOS DE LA FORMA DE APROPIACION Y
OCUPACION DEL ESPACIO EN LA PROVINCIA DE LUANDA/ANGOLA

Resumen: Las inundaciones urbanas tienen impactos significativos tanto en la sociedad como
en el medio ambiente, especialmente en regiones que experimentan una rapida urbanizacion,
como Luanda, Angola. En las dltimas décadas, la provincia ha enfrentado un intenso
crecimiento poblacional impulsado por la migracion y los asentamientos informales, lo que ha
Ilevado a un aumento de las vulnerabilidades. Este estudio analizé los efectos de la expansién
poblacional en las areas propensas a inundaciones durante 40 afios, centrandose en los hitos de
1975, 2002 y 2022. El enfoque metodoldgico incluyd entrevistas, encuestas, visitas de campo,
uso de drones y analisis cartogréfico, respaldado por herramientas como QGIS 3.2y el software
R para el procesamiento geoespacial y los andlisis estadisticos. Los resultados destacan que la
planificacion inadecuada y la ocupacion de territorios ambientalmente fragiles han
intensificado los riesgos de inundaciones, provocando deslizamientos de tierra, pérdidas
materiales e incluso muertes. Estos factores han reducido significativamente la calidad de vida
de la poblacion, lo que se refleja en indicadores socioecondémicos desfavorables. Ademas, la
presion urbana sobre areas de alto riesgo ha comprometido los sistemas naturales de drenaje,
agravando los problemas relacionados con las lluvias. La ausencia de politicas publicas
efectivas intensifica estas vulnerabilidades, lo que hace esencial adoptar estrategias de
planificacion urbana que incluyan infraestructura adecuada, gestion territorial y educacion
ambiental. Este estudio subraya la necesidad de un enfoque integrado y coordinado para mitigar
los impactos de las inundaciones y promover un desarrollo sostenible, capaz de transformar los
desafios urbanos de Luanda en oportunidades para un futuro mas resiliente y equilibrado.
Palabras clave: paisaje; vulnerabilidad; inundaciones; zonas urbanas; sociambiental.

INTRODUCAO

A ocupacdo desordenada de areas urbanas emerge como um dos principais
catalisadores da vulnerabilidade socioambiental de uma parcela significativa da populacdo nas
cidades angolanas. Nesse contexto, destaca-se a ameaca iminente das inundacdes. Nas Ultimas
décadas, Angola tem testemunhado um aumento acentuado na frequéncia e na magnitude das
inundacdes, afetando praticamente todas as regides do pais. Esse desafio preponderante €, em
grande parte, atribuido ao processo desenfreado de ocupacdo das margens de rios e a crescente
impermeabilizacdo dos solos nas bacias urbanas (Hora; Gomes, 2009). Culminando na
transformacdo das inundacdes em desastres que impactam anualmente milhdes de pessoas,
conforme dados fornecidos pela International Disaster Databas.

Diante dessa realidade alarmante, tém surgido discussdes e debates sobre a necessidade
de implementar medidas preventivas e estratégias de planejamento capazes de mitigar 0s
impactos dos eventos extremos relacionados a inundacéo (Amaral; Ribeiro, 2009). Entre essas
medidas, 0 mapeamento das areas suscetiveis a inundages assume uma funcdo crucial ao

fornecer informacgdes essenciais para a prevencao, o controle e a gestéo eficaz das inundagdes
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(Tucci; Bertoni, 2003). E importante, no entanto, reconhecer que 0 mapeamento das areas de
risco ou suscetiveis a inundacbes, por si sO, pode ndo ser suficiente para compreender
integralmente a dindmica real e os impactos das inundac6es, uma vez que o potencial de danos
também esta intrinsecamente relacionado a vulnerabilidade socioecondmica das comunidades
afetadas (Hogan, 2001).

Este estudo tem como proposito analisar a vulnerabilidade socioambiental na provincia
de Luanda, focalizando na identificacdo e no mapeamento das areas suscetiveis a inundacoes.
Luanda é uma regido de grande relevancia industrial e tecnolégica em Angola e passou por um
periodo significativo de modernizacdo nos setores industrial e agricola nas tltimas décadas INE
(2014). O crescimento urbano dessa provincia esteve intimamente ligado a crise politica e
militar em Angola, a partir de 1975, que desencadeou a realocagdo de investimentos do setor
agricola para a construcéo civil. Esse deslocamento de recursos financeiros, aliado a extensa
infraestrutura de transporte e a vocagdo da cidade como um centro comercial crucial, resultou
na transformacao de Luanda em um polo econémico de todo o pais (Cano; Brandédo, 2002).

Esse crescimento econdémico acelerado conduziu a um processo rapido de urbanizacao
e migracdo, porém, ndo foi acompanhado por uma expansdo adequada dos servi¢cos urbanos.
Isso resultou em uma utilizacdo desigual do espaco urbano, problemas relacionados ao
fornecimento de agua e tratamento de esgoto, ocorréncias de inundacdes e questbes de
transporte, devido ao elevado fluxo de pessoas e mercadorias (Vitte, 2010). A provincia
enfrenta eventos recorrentes de inundacdo, principalmente durante o periodo chuvoso, devido
ao processo de expansdo urbana que inicialmente ocorreu nas areas planas de colinas e,
posteriormente, ocupou as regides de encostas e planicies aluviais que antes eram ocupadas por
zonas de préticas agricolas (Vitte, 2010). Portanto, é essencial compreender a problematica
ambiental relacionada as inundacbes e identificar os distintos niveis de vulnerabilidade
socioambiental existentes na regido (Hogan, 2001).

Neste estudo, parte-se da premissa de que a vulnerabilidade socioambiental esta
intrinsecamente ligada ao potencial de risco de inundacdo nas areas da provincia de Luanda.
Assim, reconhecemos que ha uma correlagdo entre a densidade populacional e sua estratificacéo
em diversos estratos socioecondmicos. Além disso, € importante ressaltar que 0s aspectos pedo-
geomorfologicos em uma area com clima tropical podem frequentemente desencadear eventos

de risco associados a impactos sociais e ambientais (Tominaga, 2009).

METODOLOGIA
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De acordo com Pelling (2003), a vulnerabilidade estd intrinsecamente ligada a
exposicdo ao risco e a capacidade limitada de prevenir ou absorver potenciais danos. Ele a
classifica em trés categorias: vulnerabilidade fisica (relacionada a infraestrutura fisica),
vulnerabilidade social (associada ao sistema social, econdmico e politico) e vulnerabilidade
humana (uma combinacéo das anteriores).

Uma abordagem mais concisa é apresentada pelo National Research Council (2006),
que identifica dois principais tipos de vulnerabilidade: fisica e social. A vulnerabilidade fisica
refere-se as ameacas as estruturas fisicas, infraestruturas, meio ambiente e impactos
econdmicos. A vulnerabilidade social abrange as ameacas ao bem-estar e a normalidade da
populacdo, como mortes, ferimentos, necessidade de assisténcia médica e os impactos no
funcionamento do sistema social devido a ocorréncia de um desastre.

Concordamos com Barroca (2006) que as numerosas defini¢ces de vulnerabilidade sdo
delineadas por seus aspectos especificos e dependem do tipo de estudo, da analise realizada e
dos resultados pretendidos, bem como das caracteristicas do perigo (fenémeno natural), da
escala temporal e espacial e das particularidades do local de estudo.

Dessa forma, a adocdo da abordagem de vulnerabilidade socioambiental permite a
integracdo das dinamicas sociais e ambientais, possibilitando a identificacdo de situacdes
geogréficas distintas, uma vez que as condi¢cdes econdmicas, sociais, politicas e culturais da
populacdo influenciam tanto a capacidade de absorver quanto de resistir aos impactos diante da
materializacdo de um risco (Mendonca, 2016).

A analise dessa complexa problematica requer a utilizagdo de uma ampla gama de
variaveis, tornando essencial o emprego de técnicas e métodos adequados. Nesse contexto, a
analise espacial se funde com a tematica da vulnerabilidade socioambiental, emergindo como
uma ferramenta para reestruturar e espacializar a integracdo de dados, visando a distribuicdo
espacial e a identificacdo de padrdes (Rosa, 2011). A analise espacial possibilita a representacao
de fendmenos fisicos, ambientais e antrépicos, fornecendo, assim, uma contribuicdo valiosa

para a compreensao das interacdes e dos processos de ocupacao e transformacéo do espaco.
MATERIAIS E METODOS
Caracterizacdo da area de Estudo

Para o estudo de caso desenvolvido, utilizou-se um recorte geografico da regido da
provincia de Luanda, capital de Angola, que esta localizada entre as latitudes 8°40°35”’S e
9°20°25°°S e longitudes 12°59°18'E e 13°38°53"'E. Esta provincia situa-se na zona litoral,
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sendo limitada geograficamente pela provincia do Bengo ao Este e 0 Oceano Atlantico a Oeste.
Apresenta uma superficie territorial de 18 826 Km2, ficando situada na zona de drenagem
fluvial da Bacia Hidrogréafica do Baixo Cuanza, ambiente de deposi¢do dos sedimentos fluviais
depositados pelo rio Cuanza, que € maior rio de Angola. Segundo o INE (2014), a populacdo
de Luanda era estimada em 6.945.386 pessoas, sendo 44% do género masculino e 56% do
género feminino. Luanda possui nove municipios delimitados geograficamente, sendo o
municipio de Luanda, Belas, Cacuaco, Viana, Cazenga, Kilamba Kiaxi, Icole Bengo, Quissama

e Talatona como ilustra a Figura 1.

Figura 1 — Mapa de localizacdo geogréafica da area de estudo
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Fontes: INE (2022). Organizacéo e Elaboracdo: Khokhy Barros (2023).

O territério em questdo encontra-se em uma regido de transicdo entre duas unidades
morfoestruturais distintas. A maior parte da area esta localizada na Depressao Periférica de
Luanda, caracterizada por um relevo predominantemente plano, especialmente na regido
costeira. A cidade em si esta localizada em uma area de baixa altitude, com terreno
relativamente plano. No entanto, existem algumas areas mais elevadas e colinas ao redor da
cidade, o que contribui para certa variacdo no relevo. A regido costeira € marcada por terrenos

mais planos, enquanto areas mais distantes podem apresentar terrenos mais acidentados e
elevados.
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Procedimentos metodoldgicos

Inicialmente, construiu-se o referencial tedrico a partir da analise de relatorios, livros,
teses, dissertagdes, artigos cientificos, entre outros, conforme a orientacdo de Marconi e Lakatos
(2007). Este levantamento bibliografico sobre a problematica abordada permitiu estabelecer e
delimitar uma base referencial solida, capaz de direcionar a trajetdria da pesquisa.

Na sequéncia, foi efetuado um mapeamento da area de estudos. Para a confecgdo dos
mapas, utilizou-se software de Sistemas de Informag¢des Geograficas (SIG’s), QGIS 3.2. Em
todos os mapas, foram empregadas as bases cartogréficas (shapefiles), disponibilizadas pelo
Instituto Nacional de Estatistica (INE) de 2019 (limites de Angola, das Regides, Municipios,
entre outros). Houve a configuracdo e padronizagdo do sistema de referéncia, e aplicado: o
Sistema Geodésico Angolano (Camacupa). As shapefiles dos dados geomorfolégicos,
pedoldgicos, geomorfoldgicos e de vegetacdo sdo disponibilizados pelo Instituto Geodesico e
Cadastral de Angola (IGCA), na escala de 1:100.000. Os mapas séo recursos de comunicacéo
e linguagem, formados pelo tripé: cartografo, mapa e usuario. Com esse entendimento,
construiu-se a intengdo de cada mapa elaborado. Para confeciona-los, langcou-se mao de sinais,
simbolos e cores especificas, sendo que cada mapa possui suas especificidades qualitativas e
quantitativas. Assim, 0os mapas sao utilizados para indicar os elementos espaciais e territoriais,
a fim de permitir a cognicdo, analise, interacdo e comunicacgéo.

A elaboracdo de um mapa de crescimento urbano, Figura 2, comeca com a coleta de
dados histdricos e atuais sobre o desenvolvimento da area de interesse, abrangendo varias
décadas para permitir uma analise temporal detalhada. Inicialmente, reunir-se imagens de
satélite histdricas disponivel de 1978 a 2022, fotografias aéreas de atualizadas de 2020, mapas
topograficos que documentem a evolucdo urbana ao longo dos anos de 1975 a 2022. Essas
imagens e mapas foram obtidos a partir do banco de dados do INE, IGCA e IPGUL. Além
disso, foi fundamental coletar dados socioeconémicos que complementem a analise espacial.
Esses dados incluem censos populacionais 2014, que forneceram informacdes sobre o
crescimento demografico; registros de migracdo, que ajudaram a entender 0s movimentos
populacionais e suas causas; e dados sobre uso e ocupacéo do solo, que revelam como diferentes
areas urbanas sdo utilizadas, como residenciais, comerciais e industriais. A infraestrutura
urbana também deve ser mapeada, detalhando a rede de transporte, servicos publicos e
equipamentos urbanos, além de politicas de planejamento urbano que influenciam diretamente
0 desenvolvimento e a expanséo da cidade. A compilacdo e integragdo desses dados variados
ofereceram uma base s6lida para compreender as tendéncias histéricas de crescimento urbano,

identificar os principais fatores que impulsionaram esse crescimento e avaliar as consequéncias
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socioeconOmicas e ambientais. Esta fase inicial de coleta de dados foi essencial para garantir
que o mapa de crescimento urbano seja fundamentado em informagdes abrangentes e precisas,
permitindo uma andlise robusta e detalhada do desenvolvimento urbano ao longo do tempo.

Para realizar um mapa de vulnerabilidade social urbana de Luanda, foram identificados
indicadores socioecondmicos e demogréaficos relevantes, como renda per capita, acesso a
servicos basicos, taxa de desemprego e condi¢bes de moradia. Esses dados foram obtidos de
fontes do censo populacionais 2014, e registros administrativos, foram manipulados utilizando
técnicas de georreferenciamento e interpolacdo espacial (krigagem) e interpolacéo por inverso
do quadrado da distancia, para permitir a analise de padrfes espaciais e a criacdo de mapas
tematicos. Em seguida, os dados georreferenciados foram integrados e visualizados em mapas
que representam a distribuicdo espacial da vulnerabilidade social de Luanda. Técnicas de
analise de cluster, a analise de agrupamentos espaciais (Spatial Clustering), foram aplicadas
para identificar areas de alta concentracéo de vulnerabilidade. Alem disso, métodos estatisticos
como analise de regressao espacial foi utilizada para modelar e entender as relagdes entre os
diferentes indicadores de vulnerabilidade social.

Para realizar um mapa de risco socioambiental para inundacgdes urbanas utilizando o
QGIS 3.2, foi necessario coletar e preparar os dados necessarios para analise. 1sso inclui dados
historicos de inundacdes, dados geoespaciais como imagens de drone (Phantom Pro 4) e satélite
de alta resolucdo da GeoEye-1, que oferece imagens com detalhes de até 0,41 metros por pixel
em modo pancromatico e 1,65 metros por pixel em modo multiespectral. Este satélite é
conhecido por sua capacidade de capturar imagens de alta qualidade e precisdo, adequadas para
diversas aplicac@es, incluindo monitoramento ambiental, planejamento urbano, agricultura de
precisdo e gestdo de desastres. Para processar 0s dados no QGIS 3.2, comece-se na importacdo
dos arquivos vetoriais e raster atraves do menu "Layer > "Add Layer" para adicionar shapefiles
ou imagens de satélite. Em seguida, utilize ferramentas de processamento como "Vector™ >
“Geoprocessing Tools™ para operagdes vetoriais ou "Raster” > "Analysis™ para dados raster. A
realizacdo do buffers em poligonos usa-se "Vector™ > "Geoprocessing Tools™ > "Buffer(s)". Para
andlise espacial, explore opcdes como "Vector™ > “Spatial Analysis Tools™ para operacdes
vetoriais e "Raster’ > "Raster Calculator™ para manipulagdes em dados raster. Ajustou-se as
simbologia e estilos das camadas usando o painel de propriedades de camadas (" Layer
Properties’) e, para produzir mapas finais, crie um novo layout de impressdo em "Project” >
"New Print Layout™. Finalmente, exporte seus resultados usando "Project” > "Save As Image
para mapas ou "Layer’ > "Export’ > "Save As" para camadas vetoriais ou raster em diferentes

formatos de arquivo.
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Em seguida, utilizando ferramentas e plugins disponiveis no QGIS 3.2, realizou-se a
analise de vulnerabilidade. Técnicas como anélise multicritério (MCA) sdo aplicadas para
combinar variaveis como proximidade a cursos d'dgua, declividade do terreno, densidade
populacional e infraestrutura critica. O QGIS 3.2, permitiu a criacdo de mapas tematicos que
mostram &reas com diferentes niveis de vulnerabilidade as inundagdes, identificando locais
onde a populagdo e 0s recursos urbanos estdo mais expostos aos riscos. Finalmente, a
modelagem de risco foi realizada utilizando modelos hidroldgicos e hidrodindmicos disponiveis
no QGIS 3.2. Isso inclui a simulacdo de cenéarios de inundacdo com base em diferentes
condi¢cdes meteoroldgicas e eventos extremos, utilizando plugins como o "Flood Simulation® e
"Hydrology Tools. Os resultados da modelagem foram integrados aos mapas de
vulnerabilidade para produzir um mapa de risco completo, que ndo apenas identifica areas
suscetiveis a inundacao, mas também quantifica o potencial impacto socioambiental e orientou
atomada de decisdes para mitigacdo de riscos e planejamento urbano sustentavel. Este processo
integrado no QGIS 3.2, permitiu uma analise robusta e detalhada do risco socioambiental de
inundacdo urbana de Luanda, fornecendo as autoridades locais e planejadores urbanas
informac@es cruciais para a gestdo de emergéncias e o desenvolvimento de politicas publicas

eficazes.
RESULTADOS E DISCUSSAO

A analise do crescimento urbano da provincia de Luanda é complexa e abrange diversos
aspectos, incluindo o crescimento demografico, expansdo territorial, mudancas na
infraestrutura, impacto ambiental e desigualdades sociais. O inicio desse crescimento remonta
a fundacéo da cidade como litoranea portuguesa em 1576, com um projeto inicial para 500 mil
habitantes. Com a independéncia de Angola em 1975 desencadeou um grande fluxo de
migrantes de outras regides do pais, levando a um crescimento populacional descontrolado e a
desconfiguracdo da estrutura urbana de Luanda. Os dados da Tabela 1, destacam a intensidade

desse crescimento ao longo do tempo.

Tabela 1 - Crescimento e ocupagao urbana da populagdo na provincia de Luanda.

Ano N° populacional Taxa de crescimento na | Ocupacéo territorial % >
zona urbana % >10 100

1975 350.000 13 25

2002 1.222.408 2.6 45

2022 8.450.983 5.8 75

Fonte: INE (2023), Elaboragdo: Khokhy Barros (2023).
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Durante o periodo que compreendeu a independéncia em 1975 até a fase de aclamacéo
do fim da guerra civil em 2002, houve um notavel impulso no processo de expansao da area
urbana na provincia de Luanda. Durante esse periodo, a taxa de crescimento da populacdo na
zona urbana aumentou de 1,3% para 2,6%, e a ocupacao do territério da provincia de Luanda
cresceu de 25% para 45%. Com a conquista da paz, houve um influxo significativo de pessoas
de outras partes de Angola para Luanda, em busca de seguranca e condi¢des de vida melhores.
O répido crescimento populacional que ocorreu de 2002 a 2022, resultando em uma
ocupacdo desordenada das areas urbanas. A taxa de ocupacdo das zonas urbanas aumentou
significativamente, passando de 2,6% para 5,8%, 0 que levou ao surgimento de areas
periurbanas na principal provincia de Angola. Esse fenbmeno representa um crescimento
urbano descontrolado e exponencial, caracterizado pela falta de planejamento territorial
adequado. Como resultado, houve uma caréncia generalizada de infraestrutura urbana e uma

degradacéo dos servicos sociais, como ilustrado na Figura 2.

Figura 2 — Mapa do crescimento urbano na provincia de Luanda
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By: Khokhy Barros

Fonte: INE (2022). Organizagdo e Elaboracdo: Khokhy Barros (2023).

O crescimento populacional que derivou da desestruturacdo das zonas urbanas em
Luanda resultou em mudancas negativas na organizagdo, infraestrutura e funcionamento dessas

areas. 1sso é frequentemente associado a problemas sociais, ecoldgicos e ambientais que afetam
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a qualidade de vida dos habitantes. Uma das principais causas dessa desestruturacdo foi a
ocorréncia frequente de inundagdes devido as fortes chuvas, que danificaram as infraestruturas
urbanas. A falta de investimento na manutencdo e melhoria de elementos como estradas,
calcadas, transporte publico e redes de abastecimento de agua e energia também contribuiu para
a deterioracéo das condigcdes urbanas em Luanda.

A provincia de Luanda recebe uma precipitacdo média anual de 387 mm devido a sua
localizagdo em uma zona temperada. 1sso resulta em chuvas intensas ao longo do ano, tornando
dificil definir estacdes distintas. Os meses mais chuvosos sdo janeiro, fevereiro, marco, abril,
setembro, outubro, novembro e dezembro, enquanto maio, junho, julho e agosto s&o
considerados secos, com pouca ocorréncia regular de chuvas, como mostrado no Gréfico 1-a.

As temperaturas médias em Luanda variam geralmente de 20°C a 25°C durante todo o
ano. As chuvas sdo fortemente influenciadas pela estagdo, com a esta¢do chuvosa trazendo uma
quantidade significativa de precipitacdo. E importante observar que as condigdes climaticas
podem variar de ano para ano, e os dados mencionados sdo baseados em medias historicas e
padrdes climaticos.

As areas urbanas desempenham um papel relevante nas mudancas climaticas devido ao
fendmeno conhecido como "llha de Calor Urbano™. Isso ocorre quando as cidades tém
temperaturas mais elevadas do que as areas rurais circundantes devido a absorcéo e retencao de
calor por estruturas urbanas, como edificios e estradas. Esse fendbmeno também pode ser
observado em algumas partes de Luanda.

O Gréfico 1-b, apresenta um estudo temporal das precipitacdes ao longo dos anos de
2012, 2017 e 2022, fornecendo uma analise detalhada das varia¢des na quantidade de chuva em

uma determinada area.

Gréfico 1 - Temperatura médias e precipitagdo/clima e quantidade de chuva em Luanda.
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Fonte: INAMET (2023). Elaboracdo: Khokhy Barros (2023).
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As flutuagdes climéaticas em Luanda revelam padrbes sazonais, tendéncias de longo
prazo e eventos de chuvas intensas. Notou-se que o més de Abril geralmente apresenta a maior
quantidade de chuvas em milimetros, enquanto os meses de Janeiro, Fevereiro, Marco e 0s
meses de Setembro, Outubro, Novembro e Dezembro s&o mais secos, com chuvas menos
frequentes. O ano de 2022 registrou menos chuvas, possivelmente devido as atividades
humanas que afetam o meio ambiente.

Para as populagdes urbanas de Luanda, a ocorréncia de chuvas gera preocupacgéo,
variando de acordo com a situacdo especifica e o contexto. A variacdo nos dias de chuvas ao
longo de vérios anos. Em 2012, os meses de Marco e Abril tiveram cerca de 10 a 11 dias de
chuva. Em contraste, 2017 teve uma reducdo significativa nos dias de chuva, com apenas 6 dias
nos meses de Marco e Abril. Ja em 2022, o periodo chuvoso foi mais curto, com uma media de
2 dias de chuva nos meses normalmente mais chuvosos.

As chuvas desempenham um papel fundamental na formacdo e transformacdo da
paisagem em Luanda ao longo do ano. A quantidade, distribuicdo e sazonalidade das chuvas
influenciam diretamente a aparéncia e a composi¢cdo da paisagem, bem como a formacéo de
areas propensas a inundacdes devido ao acumulo de &gua. Chuvas intensas e frequentes em
Luanda geram sérios problemas para a populacdo, uma vez que contribuem para a formacéo de
rios, riachos e corregos, resultando em inundacGes que afetam a malha urbana. A quantidade
de agua das chuvas determina o volume e a velocidade desses corpos d'dgua, moldando a
topografia local. Quando as chuvas sdo intensas ou prolongadas, a quantidade de agua pode
exceder a capacidade dos sistemas de escoamento, como bueiros, galerias pluviais e valas de
infiltracdo, resultando no acumulo de agua nas ruas e areas de baixa altitude, conforme

mostrado no Gréfico 2-a.

Graéfico 2 - Indice de zonas com inundagdes ao longo dos anos a provincia de Luanda
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Fonte: INAMET (2023), Elaboracdo: Khokhy Barros (2023).
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A falta de infraestrutura de drenagem adequada nas &reas urbanas de Luanda tem
dificultado o escoamento eficiente da &gua da chuva. Além disso, o desmatamento, a
impermeabilizacdo do solo devido a pavimentacdo e o aumento da urbanizacdo reduzem a
capacidade do solo de absorver a &gua, levando ao aumento do escoamento superficial e,
consequentemente, ao risco de inundagdes. Estes eventos climéticos extremos, tém contribuido
na degradacdo ambiental da orla costeiras e aumentando a vulnerabilidade social das
populagcbes que vivem nas areas urbanas da cidade de Luanda.

No que diz respeito a faixa etaria dos entrevistados, a amostra apresentou pessoas com
idades entre 10 e mais de 60 anos, e foram agrupadas em faixas de 10 a 18 anos, acima de 18 a
30 anos, acima de 30 a 40 anos, acima de 40 a 50 anos, acima de 50 a 60 anos e mais de 60
anos. A maioria dos entrevistados tinham entre 30 e 40 anos, seguida por pessoas de 40 a 50
anos. No entanto, também houve uma quantidade significativa de entrevistados com menos de
18 anos, indicando que o problema abrange todas as faixas etarias da sociedade.

Entre as variaveis sociais consideradas no estudo, a ocupacgéo dos entrevistados foi um
dos principais focos. A maioria dos entrevistados (67,1%) estava empregada, superando as
expectativas iniciais da pesquisa. Em segundo lugar, estavam os estudantes (34,3%), seguidos
por aqueles que relataram realizar outras atividades (7,7%). Aqueles que declararam néo estudar
e ndo trabalhar representaram 3,4% dos entrevistados. A maioria dos entrevistados (63,8%)
afirmou ter mudado de bairro em algum momento, destacando a alta mobilidade da populacéo
na provincia de Luanda.

A construcdo de casas ou edificios tende a ser mais comum durante os periodos de pouca
chuva ao longo do ano, ja que essas épocas oferecem condicdes de trabalho mais favoraveis.
Em Luanda, a falta de chuvas cria um ambiente propicio para a construcao, facilitando
escavacOes, preparacdo do terreno e outros trabalhos relacionados a construcéo. Isso também
ajuda a reduzir os atrasos causados por condicGes climaticas adversas. O Gréafico 2-b, destaca
gue os meses de Maio, Junho, Julho e Agosto registram niveis mais altos de construcdo, em
comparacdo com outros meses mais secos. Além disso, ao longo dos anos, observa-se um
aumento no nimero de construcdes nas areas urbanas.

O crescimento das zonas urbanas na provincia de Luanda tem sido uma tendéncia
significativa e complexa. A zona urbana em desenvolvimento, muitas vezes experimentam um
rapido crescimento populacional devido a uma combinacdo de migracao rural-urbana, taxas de
natalidade mais altas e outros fatores socioecondémicos. Isso leva a um aumento na demanda
por habitag&o, servicos e infraestrutura. Foi visto no ano de 2022, que a taxa de crescimento de

construgdes, subiu significativamente no més de Junho a 98% e 96% no més de Julho.


http://www.ojs.ufpi.br/index.php/equador

Revista Equador (UFPI), Vol. 13, N° 2, Ano 2024, Edicéo Especial, p. 161-183.
Home: http://www.ojs.ufpi.br/index.php/equador

Na provincia de Luanda, o impacto da degradacdao ambiental é extremamente agravante,
suscitando uma andlise concreta da paisagem atual ao longo das areas urbanas. Esses impactos
ambientais ocorrem tanto de maneira direta quanto de forma indireta, como é demonstrado no
Quadro 1.

Quadro 1 - Impacto de desmatamento na provincia de Luanda.

Impacto diretos Impacto indiretos

- . - Reducéo da fauna silvestre
Perda da biodiversidade
- Aumento de pragas

- Modifica¢fes no regime de ventos e
Aumento da temperatura
Desmatamento chuvas

- Turbidez de agua

3 - Diminuicao da fotossintese
Aumento da erosao . o
- Reducéo da ictiofauna
- Perda de renda

Fontes: Elaboragdo: Khokhy Barros (2023).

Na provincia de Luanda, até 2022, cerca de 79,5% de toda a area desmatada
correspondia a propriedades privadas, das quais 34,1% estavam situadas em zonas rurais. Além
disso, 10,6% do desmatamento recaiu sobre o poder publico, sendo que 8,9% das terras publicas
ndo estavam designadas para ocupacdo. O desmatamento de areas protegidas constituiu 6,3%
do total, correspondendo a 1,2% nas Terras dos Nativos e 4,6% nas Unidades de Conservacéo
Natural.

Até 2022, na provincia de Luanda, a maior parte do desmatamento, cerca de 79,5%,
ocorreu em propriedades privadas, sendo que 34,1% delas estavam localizadas em areas rurais.
Além disso, aproximadamente 10,6% do desmatamento afetou terras publicas, com 8,9% dessas
terras ndao sendo destinadas para ocupacdo. As areas protegidas representaram 6,3% do
desmatamento total, sendo 1,2% nas Terras dos Nativos e 4,6% nas Unidades de Conservacao
Natural. Nas proximidades das savanas da rede hidrogréafica do rio Cuanza, a maior parte do
desmatamento ocorreu em propriedades privadas, correspondendo a 73,1% e 52,9%
respectivamente. Observou-se que os alertas de desmatamento estavam concentrados em vazios
fundiarios e a parte leste de Luanda registrou o maior aumento no desmatamento, afetando
principalmente areas privadas (84,2%), seguidas por areas rurais (45,2%), terras publicas
(37,8%) e areas protegidas (29,2%). Nos altimos trés anos, de 2018 a 2022, o desmatamento

aumentou significativamente em todas as categorias fundiarias, enfatizando a importancia
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dessas &reas para a preservacdo ambiental. Os maiores aumentos ocorreram em vazios
fundiarios (84%), areas publicas ndo destinadas (51%) e areas privadas (41%).

O mapeamento de vulnerabilidade social revelou que as areas do sul apresentam uma
predominancia das classes com Alta e Média Alta vulnerabilidade. Além disso, esse
mapeamento permite quantificar a populacdo que seria diretamente ou indiretamente impactada

pela ocorréncia do risco potencial em estudo (Tabela 2).

Tabela 2 - Analise multicritério ponderada

Mapas Influéncia (%) Classes Escala de
Valor
Alta 5

ndice de Vulnerabilidade Média-alta 4
Social 50 Média 3
Média-baixa 2

Baixa 1

Alta

5

Risco Potencial de Medla-.alta 4
Inundacdo 50 Média 3
Média-baixa 2
1

Baixa

Fontes: Elaboracdo: Khokhy Barros (2023).

Os altos valores de vulnerabilidade social podem ser observados em toda provincia de
Luanda, com uma concentracao notavel no setor sul da cidade. Essa configuracdo geografica é
resultado dos processos de urbanizacdo que ocorreram desde os anos 1975, quando a
industrializacdo comecou a se desenvolver na regido. No entanto, esse crescimento urbano nao
seguiu critérios técnicos de planejamento e careceu de orienta¢bes claras para 0 seu
desenvolvimento. Um plano de modernizagédo urbana foi implementado na década de 1980, mas
as melhorias de infraestrutura e parcelamento de terras se concentraram principalmente no
nucleo urbano, o que levou a valorizacdo dessas areas e ao deslocamento da populacdo menos
privilegiada para regifes mais distantes da cidade.

Nas décadas seguintes, houve um controle mais rigido do crescimento urbano. No
entanto, a partir da década de 1990, devido ao aumento da atividade industrial e do crescimento
populacional, Campinas experimentou um periodo de expansdo mais intensa, mas 0S Servicos
e infraestrutura ndo acompanharam esse ritmo. Essa situacdo comegou a ser abordada a partir
dos anos 2000, com a elaboracdo e implementacéo de planos diretores municipais para melhorar

a infraestrutura e o desenvolvimento urbano. A concentracdo de alta vulnerabilidade social no
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setor sul de Luanda é resultado de um historico de crescimento desordenado e desigual,
impulsionado pela industrializagéo e pelo aumento populacional, mas que, ao longo do tempo,

tem sido abordado por meio de planejamento urbano mais eficaz e politicas publicas de

desenvolvimento (Figura 3).

Figura 3 — Mapa da vulnerabilidade social urbana da provincia de Luanda.
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Fontes: INE (2022). Elaboracdo: Khokhy Barros (2023).

Foram consideradas varias variaveis que desempenham papéis essenciais nas diversas
fases do macroprocesso de reducdo de risco de desastres, abrangendo desde a prevencédo até a
recuperacdo. Essas variaveis foram baseadas em dados do Censo de 2014 e apresentaram 0S
seguintes indicadores que, a Densidade Demografica (Peso: 15%): Este indicador avalia a
concentracdo de pessoas em uma determinada area e desempenha um papel crucial na avaliacao
do risco de desastres, especialmente em areas densamente povoadas. As CondicGes de
Habitacdo e Infraestrutura (Peso: 45%): Esse € um fator critico, pois as condi¢bes das
habitacdes e a infraestrutura disponivel desempenham um papel fundamental na mitigacdo dos
riscos de desastres e na resposta a eles. A Estrutura Etaria (Peso: 5%): A composicdo etaria da
populacdo pode influenciar a capacidade de resposta e recuperacdo apds um desastre. Por
exemplo, uma populacdo com uma proporcdo significativa de idosos ou criangas pode ter

necessidades especiais. A Educacdo e Estrutura Etaria (Peso: 10%): A educagdo desempenha
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um papel importante na capacidade das pessoas de entender e responder aos riscos de desastres.
A combinagdo com a estrutura etaria ajuda a entender melhor as necessidades educacionais da
populacéo. A renda (Peso: 25%): A renda é um fator crucial que afeta a capacidade das pessoas
de se prepararem para desastres, recuperarem-se deles e reduzirem os riscos. PopulacGes de
baixa renda podem enfrentar desafios adicionais. Essas varidveis foram ponderadas com base
em sua importancia relativa para a redugéo de riscos de desastres, contribuindo para a criagéo
de um indice abrangente de vulnerabilidade social que pode informar politicas e estratégias de

gerenciamento de desastres (Tabela 3).

Tabela 3 - Distribuicio de area, populagio e rendimento médio nas classes do indice de
Vulnerabilidade Socioambiental

1VVsocioambiental Area Area Populagdo Populagdo Rendimento Médio
(km2) (%) (%) (US$)
Alta 88,11 11,09 191302 17,71 302,48
Média Alta 243,79 30,68 464489 43,00 510,89
Meédia 372,31 46,86 379717 35,16 1191,10
Média Baixa 77,05 9,70 38518 3,57 1405,78
Baixa - - - - -
N&o mapeado 13,31 1,68 6087 0,30 -
Total 794,57 100 1080113 100 -

Fontes: Elaboracdo: Khokhy Barros (2023).

A andlise da distribuicdo espacial dos indices de vulnerabilidade revela um padréo
distintivo em Luanda. As éareas classificadas como Média Baixa em vulnerabilidade s&o
predominantemente encontradas no nordeste do municipio, abrangendo a Area de Proteco
Ambiental (APA) de Luanda, bem como os municipios de Cazenga, Belas e Viana. Além disso,
também se observam essas classificacbes em menor proporcdo nas areas de cabeceiras de
drenagem, com uma cota altimétrica superior a 600 metros.

Por outro lado, as areas de Média vulnerabilidade estdo distribuidas por todo o
municipio, sendo menos frequentes na regido sul. Na regido sul, predominam as classes de
Média Alta e Alta vulnerabilidade, devido ao alto indice de vulnerabilidade social. 1sso ocorre
porque as caracteristicas fisicas, assim como o risco potencial de inundacgéo, assemelham-se as
encontradas nas areas adjacentes, principalmente na regido central do municipio. E importante
ressaltar que trechos da regido oeste e norte também foram classificados como Média Alta e
Alta vulnerabilidade, além de apresentarem um alto indice de vulnerabilidade social. Essas

areas estdo inseridas nas planicies de inundagdo dos Rios Kwanza.
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Tabela 4 - Populacdo e renda nas classes Alta e Média Alta vulnerabilidade socioambiental

IVsocioambiental [ Renda (US$) | Populagéo (%)
<120,00 73,21
343,00 a 684,00 26,60
Alta 685,00 a -
1026,00
>1026,00 0,19
<342,00 22,14
343,00 a 684,00 64,31
Média Alta 685,00 a 7,83
1026,00
>1026,00 5,72

Fontes: Elaboragdo: Khokhy Barros (2023).

A abordagem tedrico-metodoldgica utilizada destacou que, além do risco potencial de
inundacao, as condicdes de vida da populacdo, avaliadas pelos indicadores que compdem o
indice de Vulnerabilidade Social (IVsocial), desesmpenham um papel significativo no indice de
Vulnerabilidade Socioambiental (IVVsocioambiental). Isso significa que as areas com populacéo
vulneravel, especialmente nas classes Alta e Média Alta do I'Vsocioambiental, estdo localizadas
em setores censitarios onde a maioria dos residentes enfrenta uma alta vulnerabilidade social.
(Tabela 4). Essas areas também estdo espacialmente associadas a zonas com alto potencial de
ocorréncia de inundacgdes. Essa analise sistémica ressalta a interconexdo entre fatores sociais e
ambientais na avaliacdo da vulnerabilidade da populacédo. Além de considerar o risco ambiental,
é essencial abordar as condicGes de vida das pessoas, uma vez que esses aspectos estdo
intrinsecamente ligados e podem influenciar significativamente a resiliéncia das comunidades
frente a eventos de inundacéo (Figura 4).

Na provincia de Luanda, os impactos dos riscos socioambientais sdo amplos e variados,
afetando tanto as comunidades humanas quanto o meio ambiente. Esses impactos podem se
manifestar a curto ou longo prazo e tém implicacdes significativas na qualidade de vida das
populacdes, afetando areas como a saude e a economia. Um exemplo notavel desses efeitos é a
poluicdo do ar, da 4gua e do solo, que esté associada a problemas de satde publica em Luanda.
Isso se reflete principalmente em doencas respiratdrias, problemas de pele, intoxicacdo e um

aumento substancial nas taxas de mortalidade, especialmente durante a temporada de chuvas.
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Figura 4 — Mapa de risco socioambiental para inunda¢des urbanas na provincia de Luanda.
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Ao analisar os cenarios apresentados na Figura 4, fica evidente que 0s processos que
contribuem para o aumento dos indices de vulnerabilidade social estdo diretamente
relacionados aos niveis criticos de risco de inundacdo destacados neste artigo. Esses processos
consideram uma série de fatores sociais que foram mapeados nos setores censitarios urbanos,
onde a vulnerabilidade social e o perigo de inundacéo interagem e se manifestam no contexto
urbano de Luanda.

Classe de indice de risco socioambiental elevada, como retratada na imagem ndmero
um, destaca as chuvas que resultaram em trinta e cinco fatalidades no municipio do Cazenga.
A principal causa das inundag6es € atribuida as constru¢des anarquicas em locais inadequados,
um fendmeno crescente em Luanda. Na categoria de indice de risco socioambiental alto,
representada pela imagem numero dois, as intensas chuvas desencadearam inundagdes na
centralidade do Zango zero, afetando também outras regi6es da provincia de Luanda. O desastre
resultou na perda de onze vidas e no desaparecimento de mais de treze pessoas, além de deixar
milhares de familias desabrigadas. llustrando o indice de risco socioambiental médio na
imagem trés, a avaria da bomba manual no sistema de drenagem das aguas pluviais na "Vida
Pacifica", distrito Urbano do Zango zero, ocasionou inunda¢Ges em muitos edificios apds
chuvas intensas em janeiro. No indice de risco socioambiental baixo, correspondente a imagem

quatro, no municipio de Viana, entre 0s mais densamente povoados de Luanda, muitas pessoas
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ficaram impossibilitadas de deixar suas casas devido a inundacgdo causada pela falta de esgotos.
Esse cenério agravou doengas transmitidas por mosquitos, como o paludismo. Por fim, na
categoria de indice de risco socioambiental muito baixo, retratada na imagem cinco, as chuvas
recentes na provincia de Luanda continuam a deixar diversas familias desabrigadas. No
Cazenga, varias familias foram forcadas a abandonar suas casas devido as inundacdes,
buscando refugio nas residéncias de familiares e vizinhos.

Os resultados enfatizam que a vulnerabilidade das comunidades é agravada por um
processo de urbanizacdo que exclui muitos residentes, especialmente aqueles que vivem em
bairros ao longo da Orla Costeira.

A importancia de considerar a vulnerabilidade socioambiental em relagdo ao potencial
de danos as popula¢cdes humanas, como apontado por Olimpio e Zanella (2017). Além disso,
destaca que outros estudos, como os de Freitas e Cunha (2013) e Freitas et al. (2015), também
identificaram a predomindncia de fatores sociais na classificagdo da vulnerabilidade
socioambiental. Sugere que, além das variaveis sociais, outros indicadores relacionados a
exposicdo ao risco, como estrutura das edificacbes e tipo de pavimentacdo, podem ser
incorporados aos modelos de identificacdo da vulnerabilidade, conforme sugerido por
Birkmann et al. (2013). No entanto, ressalta que a selecdo de indicadores deve simplificar a
realidade para facilitar a compreensdo do fendmeno estudado, seguindo a abordagem de
(Haggett; Chorley, 1974).

Além disso, os dados sobre a distribuicdo da vulnerabilidade e da renda de Luanda,
evidenciando que uma grande parte da populagcdo em areas de alta vulnerabilidade possui renda
baixa. Também destaca que diferentes classes socioecondmicas estdo expostas ao risco, mas a
classe de menor renda é mais vulneravel devido a maior densidade populacional em areas de
risco de inundacdo. Essa concentracdo populacional em areas vulnerdveis é atribuida ao
historico de desenvolvimento urbano de Campinas, que se expandiu a partir do centro da cidade
e das vias ferroviarias em direcdo as areas de vertente e fundos de vales ao longo das décadas,

conforme observado por (Badard, 1996).
CONSIDERACOES FINAIS

Aprofundando a investigacdo sobre os efeitos decorrentes do uso irregular do solo e os
impactos socioambientais relacionados aos riscos crescentes de inundacges, emerge uma
realidade multifacetada que vai muito além das fronteiras da preocupacdo ambiental. A

ocupacdo desordenada ndo apenas aumenta a exposicdo a eventos climaticos extremos, mas
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também corroi os alicerces do desenvolvimento humano. Essa dindmica desorganizada resultou
em comunidades vulneraveis, ndo apenas diante das intempéries naturais, mas também privadas
de acesso a recursos essenciais, como infraestrutura adequada, servicos de salde e educacdo de
qualidade. As consequéncias sdo profundas, estendendo-se para além dos danos materiais,
impactando diretamente a qualidade de vida e o potencial de crescimento dessas populacées.

Assim, a busca por solugdes ndo pode ser limitada a medidas isoladas. Enquanto
esforcos imediatos para manejar o0 solo e implementar sistemas de alerta precoce sao
urgentemente necessarios, uma abordagem verdadeiramente abrangente requer um olhar
holistico para a promocéo do desenvolvimento humano. Investir em infraestrutura resiliente é
apenas o0 primeiro passo; paralelamente, séo cruciais iniciativas que promovam a educacao, a
salde, o emprego e a igualdade de oportunidades. Essas acOes sdo a base para uma sociedade
mais resistente ndo apenas aos desastres naturais, mas também aos desafios sociais e
econdmicos.

Politicas publicas integradas, sensiveis as necessidades locais e participativas, sdo a
chave para a construcdo de comunidades resilientes e prosperas. Ao unir esfor¢os na busca por
um equilibrio entre a preservacdo ambiental e o fortalecimento dos alicerces do
desenvolvimento humano, € possivel criar um futuro em que a mitigacdo dos riscos de
inundacdes coincide com a elevacdo da qualidade de vida e do bem-estar para todos o0s
habitantes. Essa jornada demanda ndo apenas a protecdo do ambiente, mas também a
valorizagéo e 0 empoderamento das pessoas, pois € nessa unido que reside a forca para construir

um futuro sustentavel e inclusivo.
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